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Our Thanks...

Thank you for choosing Guideline Geo and MALA as your Ground Penetrating Radar solution
provider. The very core of our corporate philosophy is to provide our users with the very best
products, support, and services. Our development team is committed to providing you with the
most technologically advanced and easy-to-use GPR products with the capability to meet your
needs for efficiency and productivity now, and into the future.

Whether this is your first MALA product, or addition to the MALA collection, we believe that small
investment of your time to familiarize yourself with the product by reading this manual will be
rewarded with a significant increase in productivity and satisfaction.

At Guideline Geo, we welcome comments concerning the use and experience with our products,
as well as the contents and usefulness of this manual.

Guideline Geo team
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MALA

Under the copyright laws, this manual may not be copied, in whole or in part, without the written
consent of Guideline Geo. Your rights to the software are governed by the accompanying software
license agreement. The MALA logo is a trademark of Guideline Geo registered in Sweden and other
countries.

The product described in this document is subject to continuous developments and
improvements. All particulars of the product and its use contained in this document are given by
Guideline Geo in good faith. However, all warranties implied or expressed, including but not limited
to implied warranties or merchantability, or fitness for purpose, are excluded. This document is
intended only to assist the reader in the use of the product and every effort has been made to
ensure that the information in this manual is accurate. Guideline Geo shall not be liable for any
loss or damage arising from the use of any information in this document, or any error or omission
in such information, or any incorrect use of the product. The operation, and interpretations made
based on the use, of this product is the sole responsibility of the operator.

Guideline Geo, the MALA logo, are trademarks of Guideline Geo, registered in Sweden and other
countries. Other company and product names mentioned herein are trademarks of their respective
companies. Mention of third-party products is for informational purposes only and constitutes
neither an endorsement nor a recommendation. Guideline Geo assumes no responsibility with
regard to the performance or use of these products.

Guideline Geo AB

www. guidelinegeo.com
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Introduction

MALA GroundVision 2 is the data acquisition software dedicated to the MALA ProEx system.
GroundVision 2, installed on a laptop, acquires data from the MALA ProEx control unit with
Ethernet communication. As a Windows™ based software GroundVision 2 gives you an easy-to-
use user interface, file management, printing and other key features. Each measurement and
associated settings are stored in files. Filtering can be performed with the measurement or as post-
processing. GroundVision 2 software supports both GNSS logging and multiple markers during
measurement. All radargrams can be printed as such, or post processed by further software.

Installation and Communication

The latest version of GroundVision 2 is always available to download from the web site
www.guidelinegeo.com. It is also provided on a USB when you have purchased a ProEx control unit.

When you double click on the setup file (either from the installation USB or from the downloaded
file) you will enter an installation wizard that will guide you through the rest of the installation
process.

Note: If you are doing an upgrade installation of GroundVision 2 it is recommended to uninstall the
previous version of GroundVision 2 first. This is easiest done from the Windows Control Panel,
Add/Remove programs.

System requirements: Windows 95, 98, ME, 2000, NT or XP and Ethernet communication.

To make the communication run between the Control unit and the laptop used, start up Ground
Vision 2 and go to the Tools menu -> Hardware setup.

In the Hardware setup window (see section Change hardware setup), the setting on how
communication is performed between the laptop and the control unit is made. In the Ethernet
interface drop-down-menu the available Ethernet-interfaces are seen. Choose the standard, most
often a Generic VPN.

The communication between the laptop and the ProEx control unit will work only with Ethernet on
wire.
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User interface
The user interface of GroundVision 2 is following the standard of many other Windows-based

programs. Printing as well as window managing is quite similar and follow standard Windows
commands.

Toolbar Main Window Workspace
/

"E2 oar oz | - /
Ready /v / [Trace: 7855 [Sample: 287 Post 22.07m [Depth: 45.75 ns [ mow[ 2
Workspace Tabs Radargram Status Bar

GroundVision 2 main window with a radargram opened.

Main Window

This can also be called the application window. This window holds the application’s menu, status
bar, toolbar, workspace, and the radargram windows. The main window can be minimized,
maximized, or resized to any size by the user.

Workspace

One can say that the workspace is the area managed by the user. The main window determines
the size of the workspace. The user can manipulate the radargram and trace view windows size
and position inside the workspace.

Menu
The content of the menus varies depending on whether a file is open or not or if the program is in
measuring mode. All choices that are not available are grey.

Toolbar
The toolbar holds all the buttons. A toolbar button is a shortcut to a menu command, i.e., every
button corresponds to a menu choice. If a button is greyed out that menu alternative is not
available.

Radargram
The radargram is the image generated by the measured radar data. If the amount of data is larger
than the window size, scrollbars are used to scroll the image, both horizontally and vertically. A
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mouse left click at a certain trace in the radargram shows that trace in the trace view. A mouse
right click shows a popup menu containing the radargram specific commands. When the mouse
pointer is moved across the radargram the information menu shows the actual trace number,
sample number, depth/time and position/time.

Trace View
The trace view displays a single trace, which is determined B _ =13
by position of the mouse cursor over the radargram. In data
collection mode the trace window always shows the last
incoming trace. The trace view is toggled On/Off from the
keyboard with the F10 key or opened by choosing Trace
Window under the View menu. -+ =+

When measuring in multi-channel mode with the ProEx,
there will be one trace view for each active channel.

Walug=-238 Yalug=-238

File format

When measuring with GroundVision 2, several files are generated. The most important is the data
file (.rd3) and the header file (.rad). The data file is a 16-bit binary file and contains the sample
values. The header file is a text file and contains measurement specific information. Never edit
and save the information in the header file that can cause errors in the file information and give
corrupt data. If files are to be copied to or from another computer or disc it is important that both
the data file (.rd3) and the header file (.rad) are copied.

The other files GroundVision 2 generates contains information on filter settings, palette, GPS and
markers. All the file types of Ground Vision 2 are listed below.

.rd3 16-bit binary data file

.rad Header information file

.cor Coordinate file acquired from a GPS

.mkn File with markers 1-9 with colour codes and names
il Saved filter parameters

.pal Saved palette settings

When working with several antennas and extension modules (the different slots) with the ProEx
control unit, the name for the files generated will follow this convention:

If the file name is set to PROF the file names generated by ProEx will be PROF_nnn_SC (.rad, .rd3,
.add) and PROF_nnn_S (.mrk), where:

e nnn is an automatically given number
e S gives the slot the data belongs to, Ato H
e ( gives the channel, 1 for internal Tx and 2 for external Tx.

The file PROF_0042_B1.rd3is accordingly radar data from slot B, internal Tx.
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Quick start

This chapter deals with the most essential steps for making, viewing, and printing a radar image.
Follow the five quick steps below and most of the basic functionality of GroundVision 2 is covered.
More detailed descriptions can be found in the different sections of Detailed instructions.

Power ON

First, make sure that the hardware is connected correctly, and power is on. The circle of the Start
F5 button in the tool bar of GroundVision 2 is red when the communication is working with the
ProEx control unit.

e 7

If the circle is not red, press the auto-detect key in the toolbar F9. F5 should turn red within 5
seconds otherwise a communication failure, incorrect cable connections or power failure has
occurred.

Select Measurement Settings

Chose Measurement Settings in the Measure | ]
menu or right-click on the channel to use in the Floname [Prasd
Channel navigator (F7) to access the Diectoy [ GPRDATATEST Tl
measurement settings dialog. Here the desired
filename, directory, antenna, and trigger can il Sl (e EIR
be Chosen Antenna 100 MHz unshielded -

Acuistionmode  fwheel  w]
Detailed data collection settings are found in Mossaonert uhesl [Fpdhan (58200 v [ Fevmie drecton
the Antenna Settings dialog opened Dy | wedsowm  [oiebe
pressing the Antenna Settings button. Anlornaseltngs | pddiiona o |

[ o ] Carcel |

Start and stop a measurement

Click on the start button on the toolbar, press F5 on the keyboard or select Start from the Measure
menu to start a measurement with the selected settings. To stop the measurement, click on the
stop button, press F6 or select Stop from the Measure menu.

In distance triggering mode a new trace is collected every time the wheel or hip-chain has moved
a distance interval as set in the Antenna Settings dialog. Time triggering mode works in the same
way, using the elapsed time and the time interval to determine when to collect a new trace. In
keyboard triggering mode one trace is collected every time the Enter button on the keyboard is
pressed.
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View a measured file

To open a file, choose Open (Ctrl-O) under File in the  [Bu [2]x]|
menu or click the Open file button in the toolbar. This ;t:s‘cn‘“:”e“m e T emsE
displays an ordinary' Windovys ‘open file dialog" in S e

which the user specifies the file to open. Srrocoata  [lineyos - et

CoRoHDATA  [Sinevoit
CTRATIME [Sllineyots

When a file is opened the horizontal scrolling position

is zero, i.e., the first trace is shown to the left in the Fien. [l T
radargram. Likewise, the vertical scrolling position is Fitomat  [Dats Fies o3 zl_ ew

also zero, i.e., the first samples are shown in the top
of the radargram. Use the windows scrollbars or the
arrow keys to navigate through the radargram.

Apply filters

Start by choosing Filter Manager under View in the — [Allis |
menu or right click in the radargram and choose Edit e il
Filter List or press the F key. This activates the Filter Ec'd“?’%.
Manager. To the left, there is a list of available filters s e e

. . . . . uFIg\ : |
and to the right the list of the applied filters is shown. edian ||
=

Moving average
Maoving median
Threshold

Time gain

Load list I Save list J aK LCancel ]

The functionality of the Filter Manager is straightforward. Choose a filter and click either the Add
or the Remove button and the chosen filter will be either removed or applied. It is also possible to
double click the filter to be added. By drag-and-drop the order of the filters in the Applied list can
be altered without removing and applying. The most common filters to use are DC Filter and Time
Gain Filter. See Appendix 1 Filters for more information.

The filters applied can be turned OFF and ON by pressing ® in the toolbar.

Change the palette

Start by choosing Palette Manager under View in the menu or right click in the radargram and
choose Change Palette in the popup menu or press the P key. This activates the Palette Manager.

Double clicking on a specific color box opens a Windows color dialog and a new color can be
chosen. One single right-click on a color box makes it activate for interpolating colors (indicated
by a red frame around the colour box). Another single right-click on the same color box deactivates
it. When interpolating the palette, it's recalculated depending on the colors in the active color
boxes. OK closes the Palette Manager and applies the palette to the radargram.

Note: On start-up, GroundVision 2 loads the previously used palette automatically.
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Use Contrast

The Contrast Control is found in the View menu, the Con [x]]
Toolbar or by pressing F8, and it is used to increase the ppmner e
contrast of the different radargram views. The effect of
changing the contrast is, somewhat similar to a change

in the gain function, but much easier and faster to do.

Print

To print a radargram click on the Print button in the toolbar or choose Print in the File menu. A
standard Windows print dialog will appear in which the printer to use and pages can be altered.
The default settings are the same as the default print settings for your Windows operating system.
Clicking OK prints, the radargram with the actual settings. The printout can also be inspected prior
to printout with the Print Preview in the File menu. A Print Setup function is also available in the
File menu. A standard Windows print setup dialog will appear in which the printer, paper, and
format can be altered.

Note: A Windows printer driver must be installed for the print preview function to work.

10
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Detailed instructions — Files and
Measurements

Files and radargrams

The technique used when managing the files and the radargrams in GroundVision 2 is very similar
to any other Windows program. Every radargram opens in its own window, which the user can
maximize, minimize, and resize using the standard Windows commands. No data is changed in
the data file (*.rd3) when the file is open for viewing. For this reason, there is no need for saving
when the file is closed.

Handle the trace window

The Trace Window shows a number of panels with a single trace in each. There is one panel for
every active channel. The position of the mouse cursor over the radargram determines which trace
is shown. Toggle (turn on/off) the trace window by pressing T on the keyboard, clicking the trace
window button on the toolbar or select Trace Window from the View menu.

Measuring issues

To start a measurement the communication between the laptop and the ProEx control unit has to
be functioning. If the button F5 is red the measurement can start. Otherwise F9 can be used to
connect the laptop to the control unit. During measurement the F6 button is used to stop a profile.
[t can be started again by pressing Fb5.

Note: If a profile is closed it cannot be restarted again.

Start a measurement and change the settings
A measurement is carried out with the following steps:

1. Make the correct settings for the antennas used

2. Start the measurements F5

3. Stop the measurements F6

4. If a new profile is started with the same settings, go to 2, otherwise 1.

The file name is given in the Measurement settings dialog, as well as the directory where to save
it. Observe that the file name will be automatically extended according to the convention in section
File format. Choose the correct antenna, acquisition mode measurement.

11
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In order to view or change the measurement Vieassiementsertings [X]
settings, click the Antenna Settings button in the Ftenane. [FoRD
Measurement settings dialog. [ —— .

The antenna settings are changed for the Slot

. . Slol - Channel |Internal - V¥ Active
and Channel viewed in the Measurement kS — Y
Settings pop-up. In the example at right; Slot A et Lo e 7
and Channel Internal. fegison mode [ =
Meazurement wheel ]H\pchaln[535.2E|+] j I” Reverse diection
‘wiheel source |SI St _vJ
Antenna Settings Additional Infa J
Cancel J
If the Channel navigator is opened (F7 or under o JF1|
the View menu) the settings for the different =/ ProEx

antennas connected can be changed by first
marking the antenna to change and then by
right-click on the same and choose the option
Edit Measurement Settings. This opens the
same settings dialog as explained above and
viewed below.

,rJ'-‘!':'iner'a'rh':'n'f sniiings fur stot A e ims b iR niess SO0 R e

= E Slak & - Opko module

Internal Tv
E Exhi Edit Measurement Settings

[Z] slats- ‘ I

]|

Antenna: 800 MHz shielded Slat &, channel Intermal Tx - Opta moduls

Acquisition parameters -

Antenna Separation 074 meters

e
A
Trig interval ﬁ s
Beeper active [ Samplng Frequency  [10500.2  MHz
3
il |

B0/60 Hz sensar active [

Signal parameters

TimeWindow (987608 pnz  Samples (512

Time Zem 171596 Search for Time Zero
B!
~

Autostack [~

Mumber of Stacks is

Bl

i |

bt timne windaous

o]

Shart bt

Caniel J

Example of an Antenna Settings pop-up, reached by clicking Antenna settings in the Measurement Settings pop-up.
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If there is something wrong in the ™
communication, for instance for the
transmitter antenna, the trace will not be
viewed, instead the trace window will be
black. ooy [
"

Time Zera [17198 Search for Time Zero

Slot A, channe: Internal Ts - Opta module:

Acquisiion parameters Signal parameters

Antenna Separation [0 et TimeWindow [TBT608 s Samples [512

50/60Ha sensor active [

MNumber of Stacks {256 Autostact kT

All measurement specific settings can be viewed and manipulated in the Antenna settings dialog.
The trace view displays a trace measured with the actual parameters and is updated for every
change. All controls can be managed both with the keyboard and the mouse. In the header of the
dialog the antenna changed are seen as a description of the slot and the channel.

Adjusting the Sampling Frequency and/or the Number of Samples controls the length of the Time
Window.

Note: When using GroundVision 2, do NOT set the time window to more than 3400 ns. If you need
a larger time window, contact support@guidelinegeo.com.

Sampling Frequency shall be set to approximately 10 to 12 times the antenna frequency. If the

trace view only displays a straight line, make sure that the transmitter is turned on and is correctly
connected. Does not that help; try the Search for Time Zero button.

Number of Samples shall be set to a value near 500 for the best performance. A higher number
increase the total measured time window but slow down the measuring speed and creates larger
data files.

Alter the Trig Interval (Point distance) if the default settings are not appropriate. Make sure that
the Antenna Separation is correct (this should be applied automatically depending on chosen
antenna). Otherwise, the calculation of the zero for the vertical scale will be incorrect.

The Auto stacking option is enabled by checking the Auto check box to the right of the Number of
stacks. When automatic stacking is enabled then the radar system automatically performs as many
stacks as possible for each trace. In practice this means that the number of stacks will decrease if
the antenna is moved faster and increase if the antenna is moved slower.

If the option Beeper is ticked, a beep will be given for each measurement.

When the 50/60 MHz sensor is active, EM data from the MALA HF antennas with EM option will
be collected. See HF antennas User Manual for more information.

In active mode, when the ProEx and GroundVision 2 are collecting data the radargram screen is
yellow; otherwise, the radargram window is white. An example of GroundVision 2 for ProEx in active
mode is shown below.

13
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||t wew veasue Tools window bels

oo emls o [ v

=l

Slot B - Mo madle

SlotA, Intemal 1022x733 Slot A, Internal
Value =-52 Value =52
Bl {20}

Time 5]
o 125 20 ars 500 626
1

Time Ins]

S b

5 [ par_004_. 5 Treces | )

Ready Trace: 63 |Sample: 0 Posi 69.005 [Depth: -2.86 ns UM |

When using several antennas only one radargram is shown at the time. To select which data to
show just click on the channel you want to activate in the Channel navigator (F7), right-click and
choose Toggle active.

In the main menu the position is of the profile is viewed, together with the workload indicator. This
should not go up to red more than occasionally, to give data of good quality.

2 240.00 s whorkload _

Edit the measurement information

There are two ways to bring up the Measurement n = ]
Information  dialog. Either when a new hrmaNlane  [FIEFSr

measurement is started or by selecting SampivgFrecumey BT Mz Tewidow [B1
Measurement Information under View in the Nuberof Sangles (512 Tiaseinterd 002 mates
menu. Numberof Stacks  [4

Antenna Separation {018 melers

. . . Operator N
Only the white areas allow typing/editing. When o r
desired editing has been made, OK saves the new o [
information in the header file (.rad). o oot

Cancel
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Define, save, and delete antenna settings

As changes has been made in the Antenna Settings dialog these are immediately saved for that
given antenna. To create a new antenna setting, open the Edit Antenna list dialog in the Tools
menu and press Add. The name can freely be given. Then go the Antenna settings menu and do
the correct settings.

i L %]}
Add
= | ]
Aptenina Mame: TEST 100MHA
QK | Cancel |

Apply filters during measurement

Filters (see also Appendix 1 Filters) can be applied during measurement. However, the filter
manager is not accessible during measurement. To add or remove filters or alter the settings of
applied filters the user must do the following:

e Stop the measurement (F6).
o Apply filters
e Restart the measurement (F5).

The data shown in the radargram is now filtered and the incoming data during measurement will
be filtered before shown on the display. The filters applied can be turned off and on by pressing

®

in the toolbar.

Note: Filtering during measurement increases the workload on the laptop. The acquisition speed
while heavy filtering is applied is much correlated to the power of the laptop. When the power of
the laptop is the limiting factor, vertical fields without data may occur in the radargram.

Note: Applied filters only affect the view on the display, the raw data saved on the computer is
always kept unaffected.

Change the palette when measuring
The user can define any palette and use it during measurement. The palette can be altered when
measuring, by right-click on the radargram and the choosing Change palette.

50/60 MHz EM sensor data
When measuring with MALA HF antennas with EM option the EM data can be viewed by selecting
50/60 MHz sensor data in the View menu. Both gradients of the EM sensors are viewed in the

%o

same EM window. The EM data can also be turned on and off with the in the toolbar.

15




GUIDELINEGEO | MALA
Detailed instructions — GNSS

GNSS Support

GroundVision 2 supports logging of GNSS data during measurement. The result of such a
measurement is a GNSS log file (*.cor, *.utm or *.Icf, see section File Format) in which GNSS data
are written together with the corresponding trace number. GroundVision 2 can read GNSS data
from any GNSS receiver that supports output of data with the NMEA or TSIP communication
protocols. The GNSS receiver should be connected to the serial port of the laptop. In order to make
the GNSS Manager visible chose GPS Manager under View in the main menu. This menu
alternative toggles the GPS Manager On/Off.

When first shown the GPS manager window | GPS Manaper, Q}'
(found under the view menu) gives access to = ' T
basic options only. To access the advanced Connect to GPS Igtf;ﬁﬂﬁ;e =

options just press the Advanced button. Pressing  Dlutput file farmat: i

it again will close the Advanced section of the | Ground¥fision Standard [*cor] |
dialog.

See Appendix 2 GNSS Measurements for more information.

Basic options
Connect to GPS
Press this button to activate the communication with the GNSS receiver. If there is no contact,
make sure that the communications settings (see below) match those of the GNSS receiver. When
this button is activated the GroundVision 2 software will create a *.cor-file for each radar file

d ____to Fixll _No Fix

produced and ‘La is viewed on the main menu, giving the

GNSS-position.

Interpolate positions

When the Interpolate positions checkbox is checked interpolation between positions in the data
file takes place. This procedure will give best results if the radar unit is moved with constant
velocity.

Output file format

Use this selection box to choose between the four different position output formats supported by
GroundVision2 : GroundVision 2 Standard (*.cor), WSKTRANS (*.fri), UTM coordinates (*.utm)
and Local coordinates (*.Icf).

The option Local coordinates supports GNSS systems that directly can send transformed
coordinates (with an extended NMEA-protocol).

16
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Advanced options

The advanced options are all communications settings. Normally the default settings should work
but if there is no contact with the GNSS receiver use these options to make sure that the
communications settings match those of the receiver.

e Baud rate, Parity, Data bits, and Stop bits. These are serial port communication settings,
which must match those of the GNSS receiver.

e Com Port. This setting determines which serial port on the computer to use for the GNSS
receiver. The default selection is the first serial port (COM 1).

e Protocol. Selects which communication protocol to use. NMEAO183 is a standard protocol
that should work with most GNSS receivers. TSIP is a protocol supported by Trimble GNSS
units. The default selection is NMEA.

Typical settings for the advanced option, for the
communication  between the GNSS and
GroundVision 2, are shown on the right-hand side.
The GNSS used should of course also be set
according to this and connected to the Com-port on
the laptop used.

Output file formats

When a new measurement is started a GNSS data file is created in the same directory as the files
containing GPR data. The file name of the GNSS data file is the same as for the GPR data with a
different file extension. During measurement the GNSS data file is continuously updated to
minimize data loss in occasion of a crash. A GNSS data file is created for each slot when measuring
with the ProEx control unit.

GroundVision Standard

This data file format contains the following information: trace number, date, latitude, longitude,
height above mean sea level, and HDOP. HDOP is a theoretical measure of the accuracy in the
horizontal coordinates based on the positions of the available GPS satellites. A lower value indicates
better accuracy. The date and time are expressed in Greenwich time zone.

The following is an excerpt of a *.cor file (Trace# date time latitude N longitude E “height above
MSL” M HDOP):

105 2000-9-13 11:9:33 65.18164955141 N 18.75051193218 W 357.26 M 1.454542
106 2000-9-13 11:9:34 65.18164955141 N 18.75051193218 W 357.26 M 1.454657
107 2000-9-13 11:9:35 65.18164955141 N 18.75051193218 W 357.26 M 1.454898

EU89-Geodetisk,P,G,HE
“Trace #” latitude longitude “height above ellipsoid”

UTM-coordinates

This file format contains coordinates in the global UTM system. The coordinates are calculated
from the GPS data using Redfearn’s formulas on the WGS84 ellipsoid. The file format is defined
as “Trace #” northing easting “height above MSL” “UTM zone”

17
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Detailed instructions — Markers,

Filtering, Palette

Markers

GroundVision 2 supports a multiple marker function during measurement. Up to nine markers of

different type and colour can be configured in the marker dialog.

The Markers configuration dialog is opened from the Tools
menu in the main window. All the boxes in this window will
be empty the first time GroundVision 2 is started. The nine
numerical keys 1-9 on the keyboard are predefined as
marker keys. Each key needs to be enabled by checking
the white box to the right of each key number. A new colour
can be selected by a double click on the colour box. Any
comment for each marker type can be entered in the
comments field.

A new marker file with the extension *.mkn is generated if
any marker keys are pressed during measurement. The
marker file is a text file.

WG %arE eoniation ]|

[ Markers
Keps Color  Comments

ki ¥ waterpipe
kee2 @ crossing
Kepa @[] 2mete
Keyd @ | csbie
keys5 I~ W

kewe '
Kep? [ .

ke 5]

—
kewa
o]

Cancel ‘

The first lines contain information about the header version. Following in the file there is four
columns (should be tab-separated) with trace number, sample number, marker type and marker

label.

Filtering

To be able to apply filters at least one data file must be open. The filter commands are only valid
for the active radargram. Much of the functionality described in the topics below is for mouse
usage. However, the keyboard can be used in many of these cases. Use the Tab on the keyboard
to move the input focus between functions and press the Spacebar instead of clicking the mouse.

Apply and remove filters

Start by choosing Filter Manager under View in
the menu or right click in the radargram and
choose Filter in the popup menu. This activates
the Filter Manager. To the left, there is a list of
available filters and to the right; there is a list of
the applied filters.

18

[ Filizr Hasigar

i~ Filters available
e ST

Average
Custorn gain
DC adiustment
Delete mean trace
FIR
HFIR
Median
Moving average
Maving median
Threshaold
Time gain _

<] Il._u,._.:léj

Load list I Save list J

Q

1~ Filters applied

Cancel
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The functionality of the Filter Manager is straightforward. Choose a filter and click either the Add
or the Remove button and the chosen filter will be either removed or applied. You can also apply
a filter by pressing the space key and remove a filter by pressing the Alt+R or Del, or you can both
apply and remove by holding down the mouse button and dragging the filter to the list of available
filters. By drag-and-drop-function the order of the filters in the applied list can be altered without
removing and applying.

When a filter is being applied, a filter-settings ~ [ili=iiiizss

dialog appears. Each type of filter has its own ] il
settings dialog with the specific parameters. The L |
trace window is common to all filter settin il
gs Delete mean trace Il

. . . FIR [= |

dialogs. It displays the trace chosen with the il |
. . . . . edian

Trace Control with filters applied, including the vt aveisge __‘ |

previous filters from the applied list. Teesh @

Load list I Save list I oK LCancel I

Double clicking on a filter in the applied list brings up the filter's settings dialog where the filter
parameters can be altered.

There is an option to disable all filters. To do this, press the shortcut Cirl+F or press @' in the
toolbar.

Decide what filter to use

There is no simple answer to that question. A filter very useful for some applications can be useless
in others. Depending on the application and the quality of the radar image a range of different
filters can be applied. The knowledge and experience of the user often determines the time it takes
to produce a useful image. A general recommendation is to start with DC Filter and Time Gain
Filter, after that perhaps a frequency filter or background removal filter is needed. A detailed
description of the filters is found in Appendix 1 Filters.

Palette

To be able to view, alter, load, and save the palette at least one data file must be open. The palette
commands are only valid for the active radargram.
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Change the palette
Start by choosing Palette Manager under View in the menu or right Palette Manneer q
click in the radargram and choose Palette in the pop-up menu. This

activates the Palette Manager. The palette has 30 colors. .

Double clicking on a specific colour box opens a Windows colour
dialog and a new colour can be chosen.

+2415

One single right-click on a colour box makes it activated, which
means that it will be used when interpolating the palette. Another
single right-click on the same colour box deactivates it. When
interpolating the palette is recalculated depending on the colours in
the activated colour boxes. OK closes the Palette Manager and
applies the new palette to the radargram.

Default

Load Palette

Save Palette

2415

[LLLELEARARRRRR R
1l

s

4870 Cancel

Save a palette

To save a palette click the Save Palette button and a standard Windows save dialog will appear.
Choose directory in which the palette is to be saved, type in a file name, and click the OK button.
The palette will now be saved in the specified directory with the file extension ".pal".

Load a palette

To open a saved palette, click the Open Palette button and a standard Windows open dialog will
appear. Select the palette file to be opened and click the OK button. The palette is now loaded into
the Palette Manager.

Scales

To be able to view and alter the scale settings at least one data file must be open. The scale settings
are only valid for the active radargram.

In the Tools menu, Options is found. Here the [_upilunc E3
vertical scale can be set to Time or Depth Distance urits Vetical scale Fist sl
together with the first arrival and the velocity to fieies B Sl
use. Feet Depth Ground Yelocity
s 100 meters
’T‘ Cancel ‘

Adjust for first arrival travel time

Due to antenna separation, the wave travelling from the transmitter directly to the receiver (the
direct wave) is received some time after the actual transmission. This means that the transmitted
pulse has already penetrated the medium a certain distance before the direct wave is received.
The result of this is that the depth scale zero must be corrected to be accurate.

The zero for the depth scale is calculated using the first arrival value, the antenna separation, and
the first arrival adjustment velocity. The adjustment velocity can be set to any value. Practically
however, it can be the ground velocity, the air velocity, or anything in between depending on the
antenna configuration.
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Printing

Print a radargram

To print a radargram click on the Print button in the toolbar or chose Print in File menu. A standard
Windows print dialog will appear in which the printer to use and pages can be altered. The default
settings are the same as the default print settings for your Windows operating system. Clicking OK
prints the radargram with the actual settings.

Choose the printer

There are two ways of changing the printer. If the printer is to be changed just for the actual printing
job it can be done in the Windows print dialog that appear when printing (see section Print a
radargram). If one wants to print several radargrams on a printer other than the default, that printer
can be chosen as default (see section Alter the filter settings).

Alter the printer settings

To alter the default printer settings in Ground Vision 2 chose Print Setup in the File menu. A
standard Windows print setup dialog will appear in which the printer, paper, and format can be
altered. Clicking OK makes the settings default for future print jobs. Note that these settings are
not saved and will not be the same if restarting Ground Vision 2.

Use the print preview

The print preview functionality is similar to Microsoft Word. Chose Print Preview in the File menu
and the radargram will be displayed as if it were to be printed. The print preview uses the default
printer settings. To change the appearance of the radargram in the print preview mode, change
the default printer settings (see section Alter the printer settings). When done viewing the
radargram in print preview mode, click on the Close button.
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System settings

Perform a wheel calibration

Start with connecting the control unit and the wheel to il cuiibi i x|
calibrate, .and switch on the control unit. Choose Edit T -~ New |
Wheel List under Tools menu and the Wheel i el =
Calibration List dialog will appear. Press New. oretle whenl(+ 457 30

S , , HF e b 544 50) _ x|
In in this dialog, the option of deleting wheel Conien i Pl 2T 00 —
calibrations is also found. Mark the wheel name and s |
press Delete.

Whes! Calibsation: =
MHame of new calibration 1W’heel #11 Wwiheel value [ticks) _
‘wheel source Calibration 0.00
Distance travelled iD [meters) Start calibration I Stop calibrationl

oK ‘ Cancel ‘

Type the desired name of the calibration in the Name box and choose the correct wheel source;
Master, Slot A, B, C or D. Give the correct distance for the calibration, and press Start calibration.
When the distance is travelled press Stop calibration and the option OK saves the new wheel
calibration in the control unit memory.

Note: The precision of the encoder wheel is not infinite and depending on several factors as; the
measurement surface, the pressure applied on the wheel and possible wear. If you are unsure of
the encoder wheel precision a re-calibration should be made.

Choose Measurement Units

Choose Options under Tools and the Options [ [x]
dialog will appear. Select the unit you wish to use D‘W[ — A
and then press the OK button to confirm. — — I

| 100
Ty meters
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Change Hardware Setup

The Hardware Setup dialog is divided into three

areas. The first area shows the current version  Hordwore verson: No conlol urit connecled
of the control unit firmware. If the control unit is Grglunngddl

disabled or communication doesn’t work, the Bk reblo hoodliocss o

status line of this dialog will be shown as No el

CO/’Il'TO/ Uﬂlf Connected. V' Enable DC fiter during measurement

Ethemet interface

[InteliR) Ethemet Connection (3 1218LM |

Ethemet offset correction [normally = |0

The second area is for general settings with five checkboxes. The first is for enable or disable the
audio device on the ProEx. If it is enabled, the control unit will give an audio signal at each
measured trace. The second enables the Missed traces mode. In this mode the ProEx will skip
traces when over-speeding the system. This means that the position of each trace is correct but
that there may be empty traces in the data set.

The third checkbox enables or disables a kill switch function when using the MALA High Frequency
antennas (1.2 and 1.6 GHz, US models only). If it is enabled measurements can only be carried
out if the kill switch button on the antenna is pressed down. The measurements will continue for
8 seconds when the button is released, and the stop. More information is found in High frequency
antennas User manual.

The fourth checkbox enables bidirectional measurements, used when you want to trig
measurements in both directions.

The fifth box is checked if you want to apply an DC-removal filter during measurements.

The third group in the Hardware Setup is the communication settings on how communication is
performed between the laptop and the ProEx control unit. In the Ethernet interface drop-down-
menu the available Ethernet-interfaces are seen. The communication between the PC and the
ProEx control unit will work only with Ethernet on wire.

Ethernets offset correction gives you the possibility to change the number of the network card
used. This can be needed if GroundVision 2 does not connect to the ProEx.
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Trouble shooting

Wheel calibration

The wheel calibration list is full!l Remove wheel calibrations before adding another.
The control unit memory is limited. If the area dedicated for wheel calibrations is full this error
message occurs. Remove unused wheel calibration and try again.

Wheel calibration distance is too short.
In order to make a proper wheel calibration a quite large distance should be used. Redo the
calibration over a longer distance.
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Appendix 1 Filters

This appendix covers the available filters in the
Ground Vision filter manager. The filters that have
settings that need to be set have a dialog connected
to them. This dialog can be called from the Filter
Manager and is shown in each filter description.
Common to all filter dialogs is the trace window that
shows the filtered trace. The trace window is
updated when there is a change in the filter settings.

Filizr Masigar
i~ Filters available

DC adiustment ]
Time gain 5
Delete mean trace
Average

Median

Moving average =
Moving median
Custom gain

AGC
Threshold

T

F
Triangular FIR ,_‘:l

Load list | Save list

I

-Filters applied

| o]

Cancel

Which filter to use is depending on the application and the quality of the radar image. A filter very
useful for some applications can be useless in others. The knowledge and experience of the user
often determines the time it takes to produce a useful image. A general recommendation is to start
with DC filter and Gain. Below the available filters are listed and also if they are always, often,
seldom or very seldom used in common GPR applications.

Always used: DC-shift
Often used: Delete Mean Trace, FIR, Time Gain
Seldom used:

Very seldom used:

Automatic gain control AGC

This filter attempts to adjust the gain of each trace
by equalizing the mean amplitudes observed in a
sliding time window. A short window gives a more
pronounced effect, the extreme of which would be
a one-sample window, which would cause all
amplitudes to be equal. The other extreme would
be a time window of the same length as the trace.
This would have no effect on the trace. After
equalization a constant multiplier is applied to the
trace to make the resulting amplitudes reasonable.
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Average

The Average filter calculates a mean over a given
number of samples and traces. The sample in the
middle of the grid is replaced by the average value.
This filter acts as a simple 2D-lowpass filter and

gives a softer picture.

Custom Gain
An amplifying filter where the gain factor is given
manually for 32 different sections of the trace.

DC-Filter

There is often a constant offset in the amplitude
of the registered trace, this is known as the DC
level or the DC offset. This filter removes the DC
component from the data. The DC component is
individually calculated and removed for each
trace.

In the dialog the sample interval on which the DC
component is calculated is specified. Values for
the start and end samples can be entered in the
edit boxes or by click-dragging in the trace view.
The sample interval is shown as a red area in the
trace view.
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Sample- |0
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Settings
Low limit |1
High limit |20
Trace select
215
o e 3 _1
| DO filter setiinos.
i D filEar sane]ids _
| Settings
% Start zample
[and
kil
End sample
511
Trace select
} i
g | Cancel |




GUIDELINEGEO | MALA

Delete mean trace

This filter is used to remove horizontal and nearly
horizontal features in the radargram by
subtracting a calculated mean trace from all
traces, sample by sample. The mean trace can
be calculated for the whole profile or for a
specified section of the profile.

FIR

A quick band-pass filter, working with a combination
of two boxcar (averaging) filters. The filter is run in
two stages. First the lower frequencies are
attenuated by subtracting the average in the longer
boxcar from the raw data at the centre of the boxcar.
Then the higher frequencies are attenuated by
replacing each sample with the average calculated
in the shorter boxcar.

Both boxes calculate along the whole trace.

HFIR

The HFIR filter functions as the FIR filter, but the
filter runs along the profile - not along the trace. The
filter is a spatial band-pass filter, and its effect is
similar to that of the background removal filter
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Median

The Median filter functions as the Average filter,
but instead of the mean value a median value is
used. It removes spikes in the data efficiently while
not blurring the image quite as much as the
average filter does.

Moving average

This filter takes the average as calculated by the
average filter described above and subtracts it from
the sample at the centre of the filter. Its effect is
that of a simple 2D high-pass filter.

Moving median
As the Moving average filter, but with the median
value instead of the average.

Threshold
All samples with a value below the threshold are set
to zero.
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Time-Gain Filter T gl s seamns
The Time-Gain filter applies a time-varying gain to
compensate for amplitude loss due to spreading o __|
and attenuation. The trace is multiplied by a gain —
function combining linear and an exponential gain, Exponeria
with coefficients set by the user. In the Time-Gain TE—
dialog, there is one trace window and one gain
window. The trace window shows a filtered trace, i

; P
and the gain window shows the gain function
applied. ; ; L] o |

Settings

Stail sample

The red line in the trace window indicates the start of the filter (before this point the gain of the
filter is unity).

TrlangU|ar FIR .'J'riungulur Fli¢ filear Satiinus
. . . . Settings
The Triangular FIR filter functions as the FIR filter, _- R —
but instead of using boxcar averages it uses = smeles
averages in symmetrical triangular windows. % -
Tiace select
J o
Cancel
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Appendix 2 GNSS measurements

This appendix covers some important issues when using a GNSS to position the GPR
measurements.

The Guideline Geo MALA XV Monitor or GroundVision software can be used together with GNSS
equipment which communicates via a 9-pin series connector. The GNSS must communicate with
NMEA 0183 protocol with GGA sentence. For the XV Monitor there is also one type of USB GPS
available, see the XV Monitor User manual for more information.

The GNSS equipment available today can be divided into three different types:

e GPS: Inexpensive, the GPS is using only satellites for positioning, accuracy around +4 m.
Suitable for large scale layer mapping etc.

e DGPS: Differential GPS, uses satellites and a correction from a reference station, accuracy
around = 0.5 m. Similar systems are EGNOS (Europe), WAAS (USA) and MSAS (Japan).

e RTK GNSS: Real Time Kinematic GNSS, uses two GNSS receivers (one stationary base
and one rover) and correction signal from the base antenna, accuracy around + 1 cm.
Network RTK is also available in many locations, where the correction is received via GSM.
RTK GNSS accuracy is recommended for utility mapping.

For all the three different GNSS systems the following is very important to remember:

1) Regardless the system used; GPS, DGPS or RTK, the positioning data gathered will be of bad
quality if the measurements are made under bridges, in dense forest, close to high buildings etc.
In the example below the lowermost line is measured 1 m from a building, resulting in incorrect
positioning of that measurement line.

aaaaaaaa

2) When using a GNSS in motion, the GNSS system is updated more or less seldom. Inexpensive
systems may update 1 time/second while RTK systems can update 10 or more times/second.
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3) The GNSS antenna should be placed in the middle of the GPR antenna to give the most correct
position of the GPR traces. This will be a problem when measuring with the MALA RT antennas
and should be corrected afterwards.

4) It should be observed that during the day the connection to satellites can change, giving better
or worse positioning possibilities.
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